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XVI. Plotting 
 
I.  Select AutoCAD Map Default Menu -  
 
For this module, you will be working from the basic AutoCAD Map menu. 
 
Note: As is usually the case, you can accomplish the same things using the SurvCADD menu, however the 
command pulldowns will be slightly different. 
 
If your menu defaults to a SurvCADD menu when you open AutoCAD, you will have to change back to 
the AutoCAD menu.  This is accomplished by selecting “AutoCAD Menu” from the SurvCADD “Misc” 
menu pulldown. 
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 Plotter Configuration 
 

In this exercise, you will configure an existing system plotter to be used as a default with the PLOT_PL 
drawing.  You will use an HP 750C plotter that has already been installed as a windows system printer; this 
exercise does not cover printer/plotter installation.  
 
Note: If you do not have an HP 750C installed on your system, you can substitute your preferred 
alternative. 
 
Select “Plotter Manager” from the “File” menu pulldown. 
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Select “Add-A-Plotter Wizard” from the “…Plotters” window. 
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The “Add Plotter - Introduction Page” window is displayed.  
 
Note that the wizard can configure an existing system plotter as well as a non-system plotter… and you can 
import PCP and/or PCP2 configuration files that you may have set up/used with earlier versions of 
AutoCAD. 
 
Click “Next” on the “Add Plotter – Introduction Page” window. 
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Select “System Printer” from the “Add Plotter – Begin” screen. 
 
Note on the left side of the screen that “Begin, System Printer, Import PCP or PC2, Plotter Name, and 
Finish” are highlighted.  These highlights represent the screens/steps that the wizard will guide you through 
to complete configuration. Different steps are highlighted when “My Computer” or “Network Plotter 
Server” is selected. 
 
Click “Next” on the “Add Plotter – Begin” screen. 
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The “Add Plotter – System Printer” window is displayed.   
 
Scroll down the list of system plotters to highlight the one that you want to select (the HP 750C plotter or 
your preferred alternative if the HP 750C is not available on your system.). 
 
Click “Next” to continue. 
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The “Add Plotter – Import PCP or PC2” window is displayed. 
 
If you have created and saved PCP or PC2 plotter configuration files under previous versions of AutoCAD, 
you can import them here for use with the selected plotter in AutoCAD 2000.  This is accomplished by 
clicking on “Import File…” and navigating to and selecting the desired existing PCP or PC2 file. 
 
No existing configuration files are to be imported in this exercise.   
 
Click “Next” to continue. 
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The “Add Plotter – Plotter Name” window is displayed. 
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Enter “HP750C_TRAINING” as the plotter name. 
 
Then click “Next” to continue. 
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The “Add Plotter – Finish” screen is displayed. 
 
At this point you could alter the default plotter configuration settings and/or calibrate the plotter.  For this 
exercise, leave the default settings and calibration. 
 
Default plotter configuration settings can be changed/saved at any time much in the same way as any 
“Windows” system printer (In AutoCAD, this is accomplished by selecting “Plotter Manager” from the 
“File” menu dropdown, and then double-clicking on the plotter that you want to change.). 
 
Click “Finish” to complete plotter configuration. 
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The new “HP750C_TRAINING.pc3” configuration will be added to your list of plotters. 
 
Close the plotters list window by clicking on “X” to complete the exercise.  
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Open Drawing  
 
For this exercise, you will use the file …/CADTRAIN/PLOT_PL.DWG. 

 
Select “Open” from the AutoCAD “File” menu pulldown. 
 

 
 



 129 

Navigate to and select …/CADTRAIN/PLOT_PL.DWG. 
 
Click “Open” to display the drawing. 
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Default Page Setup 
 
Select “Page Setup” from the “File” pulldown menu. 
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Click on the “Plot Device” tab to enable plotter selection. 
 



 132 

Under Plotter configuration, select the configured plotter (i.e., HP 750C TRAINING.pc3 or the configured 
plotter of your choice.).  
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Note that you can change the plotter configuration from this screen by clicking on the “Properties…” 
screen button. 
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Click on the “Layout Settings” tab to enable the layout settings window. 
 
Note the default settings for: 
 
 Paper Size / Units 
 Drawing Orientation 
Plot Area 
 Plot Scale 
 Plot Offset 
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Change Plot Area to the “Extents” to plot the drawing extents. 
 
Note that the Plot Scale changes automatically so that the drawing extents will fit on the selected paper 
size. 
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Change the paper size by selecting ANSI D – 22 x 34 in. (landscape) from the menu dropdown. 
 
Select “Center the plot” in the Plot offset area. 
 
 

 



 137 

Note that the plot scale changed to 1 inch = 92.82 drawing units.  From that, we know that the drawing will 
fit on the selected paper size (i.e., 22 x 34-inch sheet) at that scale or smaller. (???) 
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Under Plot scale, change the scale to 1 inch = 100 drawing units so that the plot is produced at an easily 
readable/measurable scale. 
 
Note that the drawing can be directly plotted from this window by clicking on the Plot button at the bottom.  
Do not plot at this time; you will plot directly from the plot window in the next exercise. 
 
Click on “OK” to close the Page Setup window. 
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Save the edited settings by selecting “Save” from the “File” menu dropdown.  The drawing will now 
default to these page / plot settings every time it is opened. 
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Direct Plotting 
 
Select “Plot…” from the AutoCAD “File” menu pulldown. 
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The Plot window is displayed/opened. 
 
Note that except for the preview buttons at the bottom, it is the same as the Page Setup window that you 
used previously to select the plotter and alter the default plot settings. 
 
Click on the “Full Preview…” button at the bottom. 
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A “preview” of the plot is displayed.  Note the command line. 
 
“Right-click” (press the right button) on your mouse to display a shortcut menu. 
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Note that you can exit, plot, or perform various zooms from the shortcut menu. 
 
Select “Exit” to return to the main Plot window (Pressing ESC or ENTER in the previous window would 
also have displayed the main Plot window.). 
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After verifying that the plotter is turned on and the appropriate paper is loaded, select “OK” to plot the 
drawing. 
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Creating a Layout 
 
Notice that when the drawing opens, the view defaults to Model space (note the “Model” tab at the bottom 
of the drawing window is highlighted/active and a “Model” button appears at the bottom of the AutoCAD 
window.).  
 
Model space is the area where drawings are normally created / edited.  You also can plot directly from 
model space as shown in the previous exercise. 
 
AutoCAD is set up to allow custom views of a drawing to be displayed and plotted as “Layouts” in Paper 
space.  Paper space represents the actual page to be plotted. 
 
Clicking on the Model button at the bottom of the screen toggles the drawing between Model and Paper 
space. 
 
Note also that two Layouts are created automatically when a drawing is created. 
 
Click on “Layout 1” tab to change to Paper Space. 
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AutoCAD switches to the “Layout” view and the Page Setup window appears. 
 

Note:  If you have previously created a layout, the page setup screen will not automatically appear.  If this 
occurs, select “Page Setup” from the AutoCAD “File” menu. 
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Click on the “Plot Device” tab in the Page Setup window and make sure that the desired plotter is selected 
(in this exercise, the plotter is “HP750C_TRAINING.pc3”).   
 
To select the plotter, click on the down arrow button in the “Plotter configuration” area, and scroll to / click 
on the appropriate plotter. 
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Next, click on the “Layout Settings” tab. 
 
Under Layout Settings, click on the Paper size menu and scroll to/ select “ANSI B –11 x 17 in. 
(landscape)”. 
 
Note the other settings: 
 
 Layout name (default “Layout 1”) 
 Page setup name ( default / no specific name) 
 Scale (default 1:1) 
 Plot area (default “Layout”) 
 Plot offset (default “0”) 
 Plot options (default “plot with plot styles” & “plot paperspace last”) 
 
These settings can be changed at any time by changing to the Layout/Paper space mode and selecting “Page 
Setup” from the AutoCAD “File” menu pulldown. 
 
Click “OK” to finalize the layout settings and display the created layout. 
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A single viewport layout has been created that will plot the drawing extents on an 11” X 17” sheet using 
the HP750C_TRAINING plotter configuration. 
 
Multiple viewports can be created on a single layout/page.  Although not included in this example, note that 
additional viewports can be added/inserted by selecting “Viewports/ New Viewports…” from the 
AutoCAD View dropdown menu.  
 
Note that the display is Layout 1 (Layout 1 tab is highlighted/active) and in paper space (“Paper” button 
replaced “Model” button at bottom right of AutoCAD window.). 
 
The paper plot area is represented by a dashed line. 
 
The drawing “viewport” is represented by a solid line around the drawing. 
 
The viewport size, position, and scale properties are automatically set so that the entire drawing is visible.  
You can view/alter the properties in paper space in the same way as any drawing properties are 
viewed/edited. 
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Viewing Viewport Properties 
 
While in paper space mode (i.e., PAPER button is visible on lower right hand side of AutoCAD window), 
viewport properties can be viewed and changed like any drawing properties. 
 
Select the viewport by clicking on the solid line around the drawing; the line grips will become visible. 
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After the viewport is selected, open and view the properties window by clicking the right mouse button and 
then scrolling to / selecting “Properties” from the menu. 
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The “Properties” window for the viewport is displayed. 
 
Scroll up and down to review the viewport properties. 
 
Note that the viewport scale is 0.004  
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Editing Viewport Properties : Scale 
 
The existing viewport scale factor of 0.004 equates to 1 plotted inch = 250 drawing units.  Drawing units in 
this example are “Feet,” so the plotted scale is 1”=250’. 
 
We want the drawing to plot at 1” = 200’, so the scale factor would be1/200 or 0.005. 
 
Click on the scale row and change the scale (factor) to 0.005. 
 
Then click anywhere on the drawing to apply the new scale to the viewport. 
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Next, close the properties window by clicking on the “X” in the upper right hand corner. 
 
Layout 1 remains with the viewport at a scale of 1” = 200’. 
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Editing Viewport Size / Position 
 
Note that when you alter the scale, the entire drawing may no longer be visible in the viewport.  You will 
have to change the position and/or size of the viewport so that the desired portion of the drawing is visible 
at the chosen scale. 
 
If not already done, click on the viewport outline to select/ highlight the line grips. 
 
Click on the grip in the upper right corner to select (grip will turn red). 
 
Move the grip to a position down and to the right so that nearly only the portion of the drawing (right-hand 
side) shown in dark blue and dark red are visible.  
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Repeat the process for either one of the left viewport grips so that all of the dark blue and red lines on the 
left extent of the drawing are visible.   
 
This adjusts the viewport size so that the regarded area (indicated by dark blue and red contour lines) are 
shown and there is still enough space for a title block, etc. on our 11 x 17-inch sheet. 
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Next, you must position (i.e., move) the viewport towards the top of the layout/sheet to allow space for the 
title block at the bottom.  In the layout view, the viewport can be “moved”  like any other entity/block in 
AutoCAD using the “Move” command. 
 
If not already done, select the viewport by clicking on the solid line around the drawing. 
 
Next, begin the AutoCAD “Move” command by selecting “Move” from the “Modify” dropdown menu. 
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As directed on the command line, you must specify a base point. 
 
You have the option of  “clicking” on any desired point on the drawing or manually entering a point 
specification on the command line; for consistency in completing this exercise, you will specify a point by 
typing  “2,2,0” on the command line.  
 
Type “2,2,0” and hit “Enter”. 
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Next, specify the second point of displacement as “2,5,0”. 
 
Type “2,5,0” and hit the “Enter” key. 
 
This moves the viewport three units in the “Y” direction. 
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Inserting a Title Block 
 
In this exercise, you will insert a pre-defined title block to complete the layout sheet. 
 
Make the layer “Title Block” the current active layer by selecting it from the layer list dropdown. 
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Select “Block…” from the “Insert” menu dropdown. 
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Navigate to and select the title block created in the title block exercise. 
 
Click “Open” to insert the block. 
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Verify that the X, Y, and Z Scales are set to “1.0”. 
 
Verify that there is a check mark next to “Specify On-screen” in the “Insertion Point” area. 
 
Click “OK” to continue. 
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Position the title block so that it centered on the sheet (i.e., within the dashed lines) and around the 
viewport.  After position is selected, “Click” the left mouse button to set/finalize title block insertion. 
 
If necessary, re-size/position the viewport (as shown in the previous exercise) so that it can fit inside the 
title block area. 
 
This completes the sample layout; the drawing is ready for plotting. 
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Plotting the Layout 
 
While remaining in the Layout 1 view, select “Plot…” from the AutoCAD “File” menu pulldown. 
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The Plot window is displayed with plot settings as specified during the layout creation process (Part VI. 
Creating a Layout). 
 
Verify that the correct/desired plot device is specified and that paper size is ANSI B – 11 x 17 in. 
(landscape). 
 
Also note that “Layout” is selected under “Plot area” and the “Plot scale” is “1 inches = 1 drawing units”. 
 
When plotting from layouts, the scale should generally be 1:1 as one of the purposes of using layouts in 
paper space is to set-up and view your drawing/portions of your drawing in a viewport of pre-determined 
scale (i.e., if you set up a viewport at a scale of 1 inch = 200 feet, and then change the scale in the plot 
window, the viewport scale(s) will no longer be valid when plotted.). 
 
Click on the “Full Preview…” button at the bottom of the window. 
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A “preview” of the plot is displayed. 
 
Once you review the plot and verify it is what you expected, press “ESC” or “Enter” to return to the plot 
window. 
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After verifying that the plotter is turned on and the appropriate paper is loaded, select “OK” to plot the 
drawing. 
 

 
 
Once plotting is complete, close the drawing. 
 

THIS COMPLETES THE PLOTTING MODULE 
 
 

XVII. Q&A 
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